2.7.2 Modify an Item during Review
Make corrections to an item
When you modify an item this creates a new version of the item. If you choose to return the item after modifying it, the new revision of
the item must be reviewed again. Users that previously reviewed the item must review the new changes to the item so the item can be
either advanced or returned.

1. Click the Modify button on the Review Questions page. On the Modify Question page, which is identical to the Write Questions page
that authors view, you may be asked to enter a reason for the modification if the project configuration requires it.

2. A message notifies you that you checked out the item thus preventing other users from editing the item until you check it back in.
When the item is checked out, the Modify button is disabled for all other users on the Review Questions and Examine
Questions pages. Project Managers can override this check-out from the Examine Questions page by clicking the Check-in b
utton.

Make the required edits to the item.

3. You have four options once you have completed the edits to the item.
a. Click Save: The changes are saved, the item remains checked out, you stay on the Modify Question page, and a message
notifies you that changes to the item have been saved.

Project Managers have the ability to check in an item while a Reviewer is actively working on an item. If the Project
Manager checks-in the item, modifies the item and Submits the item, a new revision of the item is created. The
Reviewer editing the item is not notified until they click Save, Advance, Return or Exit. A new message stating, "It is
not possible to save this item as it has been updated. Refresh the page to load the latest data; you will need to
input any changes you made again before saving."

If a Project Manager deletes an item while a Reviewer is actively editing an item, a message notifies the user that, "It
is not possible to save this item as it has been deleted."

If a Project Manager makes an item so it is no longer editable in the current project while a Reviewer is actively editing
the item, a message notifies the user that, "It is not possible to save this item as it is no longer editable on the
current project."

b. Click Advance: The changes are saved, the item is checked-in, and the item is advanced to the next reviewer in the list or to the
next stage in the workflow. If multiple Advance Outcomes are configured, the final reviewer must select where to advance the
item by selecting the Outcome drop-down list.

Advance states can be configured to require a comment. See Review Workflow for details on how to configure an
Advance state to include a comment.
Outcome State with no required comment

Outcome State with required comment

c. Click Return: The changes are saved, the item is checked-in, and a new revision is created, you must add a Comment, and the
item is returned to the previous workflow state. If multiple users must review the item, they must review this new version of the
item even though they may have already reviewed the old version of the item.

When multiple Outcomes are possible, only the last reviewer has the ability to choose where to send the item when returning it.
Select where to return the item to from the the Outcomes drop-down list.

If you need to see the items in order enter your comment, you can move the Return Question pop-up window around
on the page. Just click anywhere in the pop-up and drag the window to another location within the ExamDeveloper
window.

d. Click Exit: Cancel all changes to the item, return to the Review Question page, and the item remains checked-out. If you want to
check-in the item, click the Check-in button.

Change a Review action for previously reviewed and modified items
When you advance or return an item, you have the option to change your mind and change the review action for the item as long as the item is
still in the current review state and you currently have more than just the one item in the review queue. For instance, the review workflow is
configured so that two users are required to advance an item. The first reviewer has the option to change the review state from Advance to
Return. The Final reviewer would not have the option to change the review state. In the following steps, we are assuming the initial review for the
item is to advance the item. These same steps can be followed to reverse a Return step to an Advance step.
This action is only possible if multiple items are in the review queue for the reviewer.

1. Open an item for Review and click the Modify button.
2. Make the necessary changes to the item and click the Advance button.
3. Click the Previous navigation button to move back to the item.
A message in red states You have reviewed this question recently. The User Tracking tab lists the review state as Advance.

3.

4. Click the Return button.
5. Enter a Return Comment and click Submit.

6. Click the Previous navigation button to move back to the item.
The User Tracking tab now lists the review state as Return.

Locked Items
Project Managers have the ability to override item locking. If a Project Manager checks-in an item that a Reviewer is editing and then
checks-out the item, when the Reviewer tries to Save the item they are editing a message at the top of the page notifies the Reviewer
of the name of the user who checked out the item and provides a time stamp for when the item was locked.

Item Types except Shared Option List (R-Type) items:

To remove an Option, you can simply click the
Remove Distractor icon, or click the
Add Distractor icon to add one. The
order of the Options can also be changed by using the up and down arrows to the right of the option.

You can modify the type of an item from the Question Type drop-down list for items that are not of the type Shared Option
List (R-Type). Such an item type cannot be changed to the type Shared Option List (R-Type).
An item can now be modified even if it has been included in a published exam form or section.
An item contained in a published section can be modified without having to change the state of the section, even though a
section itself cannot be unpublished.
Items in a published exam form or section are now in a Completed state as against the Locked state in previous versions of
ExamDeveloper. Once modified, the item retains its Question ID, but is assigned a new Revision Code.
The published exam form retains the version of the item before it was modified. If the item is added to a new exam form, then
its latest version is used.
All versions of the items can still be viewed in the History tab, along with the respective Revision Codes, while examining the
item.

Shared Option List (R-Type) Items:

Modify the Lead-In, Item and/or Answer Options on the Options tab, as well as Item Stems and/or Correct option choice on the Stems tab, as
necessary.
If you missed adding enemies in the Write Question page, you can add enemies from the Modify Question page. To add enemies
refer to Create Item Enemies.
Users cannot specify an item as an enemy if it is in the same case/section/exam form as the current item.

Modify the R-Type Item Stems
To remove an Item Stem, you can simply click the
Remove Distractor icon, or click the
Add Distractor icon to add one.You
can also add stems of other R-Type items present in the project, to the Stems tab of an R-Type item. The order of the Item Stems can also
be changed by using the up and down arrows on their right.
1. On the Stems tab, click the Search for Stems button to search for and add additional Item Stems.

2. A new window opens with the usual options to retrieve items. The Type search criteria and Shared Option List (R-Type) are selected by
default. Selecting any other search criteria still results in only R-Type items being displayed on this page, as long as the criteria holds
true. Other item types are be displayed.
3. Click the Retrieve Questions button to display R-Type items from the currently selected project. The result lists R-Type items according
to the search criteria with the Question ID, Lead-In, Stem IDs of all available Stems separated by commas, Stem count, and author
name.

4. Select the check box corresponding to the item whose Stems are to be added to the R-Type item and click the Add Question Stem butto
n. All the Item Stems from the selected R-Type item are added to the R-Type item being modified. If you do not require all the Stems from

that R-Type item, you may remove the unwanted ones by clicking the

Remove Distractor icon corresponding to them.

Only the item stems are imported from the other item. You must add the correct option answers to the Options tab.

5. Select one of the Shared Options as the correct option for this new Item Stem.
User is advised not to reorder or modify the number of Item Stems for R-Type items that have multiple language versions, as
this can have undesirable results when exported to Pearson VUE Compiler.

A user cannot modify the item type of a Shared Option List (R-Type ) item from the Question Type drop-down list.
When a user modifies and saves an item, it is the same as if he/she has approved the item. Therefore, the system
automatically registers the modification as an "Advance." However, note that anyone else who "Advanced" the item
previously must review that user's changes and "Advance" the item again.

6. Click one of the following options:
Save button: Save the R-Type item’s modifications. Reviewer stays on the Modify Question page, and the item remains
checked-out.
Finish Later button: Save the changes made to the item without forwarding the item in the review process. The item is
checked-in and the reviewer returns to the Review Questions page.
Advance button: Save the changes, checks-in the item, and moves the item forward in the review process.
Cancel button: Cancel and return to the Review Questions page. The item remains checked-out. Click the Check-in button if you

need to check-in the item.

When a user tries to Save, Advance, or Return an item with Statistics tied to the version after modifications, he/she sees a pop-up
message prompting him/her to Retain Statistics, Do not retain Statistics, or Cancel if the Outcome Statistics are set to Reviewer
choice on the Review Workflow page. If the Outcome Statistics are set to Always Retain, this message is not displayed. See Review
Workflow for details on how to configure the Statistics.
Retain Statistics: Statistics of the item prior to modifications are inherited by the modified item.
Do not retain Statistics: The modified item does not have any Statistics.
Cancel: Discards the edited content and does not update the item.

The pop-up to confirm retaining statistics is not shown while saving the item with statistics after modifications if the Show 'Retain
Statistics' pop-up warning for modified items check box on the Project tab of the project's configuration page is not selected, and
the statistics are retained. This check box is enabled by default, and therefore the pop-up also appears by default.
The user must have Review Question or Validate Question permission to modify an item.

If an item being reviewed has statistics attached to it, and the last Reviewer Returns or Advances it, then a pop-up window appears
prompting the Reviewer to explain the reason for returning or advancing the item in a Rich Text Editor window. All other reviewers
except the last reviewer can only add comments on why they are returning or advancing the item. Also, there are two radio buttons:
Retain Statistics: Statistics are retained while rejecting the item.
Do not retain statistics: Statistics are removed from the item being rejected.
If there are more than one Outcomes for returning or advancing the item you must select where to return the item to from the Outcome
s drop-down list.

If there is only one Outcome for returning or advancing the item, the Outcome is listed.

Submit button: The item is returned to the author so that he/she incorporates changes as usually specified in the Rich Text edit
or. The item state changes to Returned if all Reviewers return it. The pop-up window closes and the Reviewer is returned to the
Project Review Summary page.
Cancel button: The pop-up window closes while discarding any changes it contains and the Reviewer returns to the Review
Questions page for that item.

If you do not select an Outcome, enter a Comment in the Rich Text editor, or select what to do regarding Statistics and click Submit
button, then the following error message is displayed.

Select an Outcome, enter an appropriate reason for returning the item and also select a radio button for retention or non-retention of
statistics before clicking Submit button to avoid the above errors

How does the ‘Retain Statistics’ pop-up setting at Project and Review State affect Reviewers while modifying a Question with
statistics?
The pop-up window to confirm whether or not to retain statistics while trying to save an item with statistics after modifying for a Review
State is not shown if the Show 'Retain Statistics' pop-up warning for modified items check box on the Review Workflow page is

not selected. This check box is enabled by default, and therefore the pop-up window also appears by default. Also, the pop-up window
to confirm whether or not to retain statistics while trying to Advance or Return an item with statistics after modifying a Review State is
not shown if the Advance or Return Outcome statistics is set to Always retain on the Review Workflow page.
If the Show 'Retain Statistics' pop-up warning for modified items check box at the Project level is not selected, then the check box
on the Review Workflow page is grayed out and the statistics retained while saving an item with statistics after modifying for any
Review State.

Blueprints, references, comments, and metadata can also be modified in the same way as on the Write Question page.

Modify an item with multiple language versions
When the default language version of an item having multiple language versions in a project is modified, task notifications are created to modify
the remaining language versions of the same item to reflect the change of content. This happens when one or more of the following modifications
are made: Stem, Answer Option, Correct Answer Option, adding/deleting Answer Options, Lead-In, Assets, adding/deleting Stem, and changing
the item type.

In order for a task notification to modify other language versions of an item, to be created once the default language version of the item
is modified, the check box next to Create task for notification of any Question from Group in the project’s Configuration page must
be selected. If this check box is not selected, then the task notifications are not created.

Once the default language version of the item is modified, task notifications appear under the My Tasks section on the home page, prompting the
user to modify the remaining language versions of the same item.
When a Project Manager/Reviewer modifies the default language version of an item, task notifications to modify the remaining
language versions of the same item are created and assigned to the respective writers of the items except for the writer whose
item has been modified.
When a Project Manager modifies the default language version of an item he/she has created on behalf of another user, task
notifications to modify the remaining language versions of the same item are created and assigned to the respective writers of
the items except the Project Manager who has created the item on behalf of another user.

Click the task titles under My Tasks on the home page, the Task View page opens and displays information about the task. As you can see in
the screenshot below, a deadline of 7 days from the date of modification of the default language version of the item is set to complete the said
task.

A section cannot be unpublished, once it is part of a published exam form. An item contained in such a published section can
still be modified without having to change the state of the section.
No task notification is created if a translated version of the item is modified.
The Language Code of an item cannot be modified once it is set while its creation.

Visit Work with Enemy Items to learn more about enemy items.

